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Performing Channel Modifications 
 
 
   The channel modification option in HEC-RAS allows the user to perform a 

series of trapezoidal cuts into the existing channel geometry.  In general, this 
option is used for planning studies, but it can also be used for hydraulic 
design of flood control channels.   

 
   This chapter does not cover the concepts of stable channel design.  This 

software is designed to evaluate the hydraulics of various channel 
modifications.  It is up to the user to ensure that any channel modification will 
not cause further scour of the channel bed and banks.  Discussions on stable 
channel design can be found in many hydraulic text books, as well the Corps 
Engineering Manual "Hydraulic Design of Flood Control Channels" 
(USACE, 1991). 

 
   This chapter discusses: general modeling guidelines for using the channel 

modification option; how to enter the necessary input data; performing the 
channel modifications; and how to compare existing condition and modified 
condition results. 
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General Modeling Guidelines 
 
   In order to perform a channel modification analysis, the user should first 

develop a hydraulic model of the existing river reach containing the area in 
which the channel modification will be analyzed.   This model should include 
several cross sections downstream from the study reach, such that any user 
defined downstream boundary condition does not affect the hydraulic results 
inside the channel modification region.  The model should also include 
several cross sections upstream of the study reach, in order to evaluate the 
effects of the channel modification on the water surface profile upstream. 

 
   Once a model of the existing river system is completed, the user can use the 

Channel Modification option to perform trapezoidal cuts and fills into the 
existing geometry.  Once the user has performed all of the desired channel 
modifications, then the modified geometry data is saved into a new geometry 
file.  The user can then create a new plan, which contains the modified 
geometry and the original flow data that was used under the existing 
conditions plan.  Computations can then be performed for the modified 
condition, and the user can compare the water surface profiles for both 
existing and modified conditions. 

 
   The channel modification option in HEC-RAS allows for:  

� Multiple trapezoidal cuts (up to three) 
� Independent specification of left and right trapezoidal side slopes 
� Ability to change the Manning’s n value for the trapezoidal cut 
� Separate bottom widths for each trapezoidal cut 
� Ability to set new channel reach lengths 
� Multiple ways of locating the main channel centerline 
� User can explicitly define the elevation of the new channel invert, or it 

can be based on the original channel invert, or it can be based on 
projecting a slope from a downstream cross section or an upstream cross 
section 

� The centerline of the trapezoidal cut can be entered directly, or it can be 
located midway between the original main channel bank stations 

� Option to fill the existing channel before performing cuts 
� Cut and fill areas and volumes are computed 

 
 

Entering Channel Modification Data 
 
   Within HEC-RAS, the data for performing a channel modification analysis 

are entered from the Geometric Data window.  The channel modification data 
are stored within the geometry file of the base geometric data ( the geometric 
data set in which the channel modification is being performed on). 
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   To bring up the Channel Modification Data window, select Channel 
Modification from the Tools menu of the Geometric Data window.  When 
this option is selected, a Channel Modification window will appear as shown 
in Figure 13.1 (except yours will not have any data in it the first time you 
bring it up). 

 

 
 

 Figure 13.1  Channel Modification Data Editor 
 
 
   As shown in Figure 13.1, there are several pieces of data that the user must 

enter in order to perform a channel modification analysis.  The editor is 
divided into three separate areas.  The top portion of the window contains 
selection boxes for the River and Reach; titles for the base geometry file and 
the modified geometry file; buttons for performing the cuts and viewing cut 
and fill volumes; and controls for rotating the graphic.  The middle portion of 
the window contains a data input area for entering channel modification 
information over a range of cross sections, as well as a graphic of the cross 
sections that are being modified.  The bottom portion of the window contains 
a table that lists the channel modification data for all of the cross sections in 
the selected Reach of a particular River. 

13-3 



Chapter 13  Performing Channel Modifications 
 

   The first step in performing a channel modification is to select the River and 
Reach in which you want to perform the analysis.  This is accomplished from 
the River and Reach selection boxes in the upper left corner of the window.  
The next step is to select a range of cross sections in which you would like to 
perform a channel modification.  This is accomplished by first selecting a 
cross section from the Starting Riv Sta box and then from the Ending Riv 
Sta box.  Once this is done, all of the cross sections within the range of the 
specified starting and ending river stations will appear in the graphic on the 
right.  The next step is to specify the channel modification data that you 
would like to apply to this range of cross sections.  This is accomplished by 
entering information into the table contained in the "Set Range of Values" 
area of the window.  This table allows the user to enter information for up to 
three cuts, which can then be applied to the selected range of cross sections.  
The information contained in this table is as follows: 

 
   Center Cuts (y/n): This column in the table is used to define how the 

trapezoidal cuts will be centered within the existing cross section data.  If the 
user enters a "y" in this column, then that particular cut will be centered 
between the existing cross-section main channel bank stations.  When all of 
the cut information is entered, and the Apply Cuts to Selected Range button 
is pressed, the program will automatically fill in the center stationing of the 
trapezoidal cuts in the lower table.  If an "n" is entered, then it is up to the 
user to specify the center stationing for each cross section, and each cut, in 
the table at the bottom of the window.  

 
   Bottom Width: This column is used for entering the bottom width of the 

trapezoidal cuts.  If this column is left blank, it is assumed that the bottom 
width will be zero.  The user always has the option of directly entering the 
bottom width for each cross section in the table at the bottom of the window. 

 
   Invert Elevation: This column is used to specify the invert elevation of the 

trapezoidal cuts.  If this column is left blank for a particular cut, then it is 
assumed that the invert elevation of that trapezoidal cut will be set equal to 
the invert elevation of the existing channel.  If the user wants to have invert 
elevations that are not equal to the existing channel inverts, then they must 
enter elevations into this column and select one of the slope projection 
options below this table.  The user has the option to use the specified invert 
elevations for each of the cross sections in the selected range; or they can 
enter elevations for the most upstream cross section and have the other invert 
elevations computed by projecting the cuts on a constant slope; or the 
elevations entered can be applied to the most downstream cross section of the 
range, and all others will be computed by projecting a user specified slope 
upstream. 
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   Left Slope: This column is used to specify the slope of the left bank for each 
of the trapezoidal cuts.  The slope is entered in units of horizontal distance to 
one unit in the vertical.  (e.g.,  a value of 2 means the left bank slope will 
project 2 feet horizontally for every 1 foot vertically). 

 
   Right Slope: This column is used to specify the slope of the right bank for 

each of the trapezoidal cuts.  The slope is entered in units of horizontal 
distance to one unit in the vertical.  (e.g.,  a value of 2 means the right bank 
slope will project 2 feet horizontally for every 1 foot vertically). 

 
   Cut n Val: This column is used to specify the new Manning’s n value to be 

applied to each of the trapezoidal cuts.  If this column is left blank for any 
cut, then the existing n values will be used for that cut. 

 
   Once this table has been filled out, the user must select one of the three slope 

projection options listed below the table.  The three options are: 
 
   Same Cut to all sections: If this option is selected, then the channel 

modification data entered into the table will be applied to all of the cross 
sections in the selected range. 

 
   Project cut from upper RS at slope: When this option is selected, the invert 

elevations that were entered into the table will be applied to the most 
upstream cross section in the selected range.  The invert elevation of all of the 
other cross sections will be based on projecting a user entered slope from the 
most upstream cross section to each cross section downstream.  The user must 
enter a slope when this option is selected.  The elevations of each cross 
sections trapezoidal cuts are based on the user entered slope times the 
distance that each cross section is from the most upstream cross section.  The 
distance is the cumulative main channel reach length for each of the 
individual cross sections. 

 
   Project cut from lower RS at slope: When this option is selected, the invert 

elevations that were entered into the table will be applied to the most 
downstream cross section in the selected range.  The invert elevation of all of 
the other cross sections will be based on projecting a user entered slope from 
the most downstream cross section to each cross section upstream.  The user 
must enter a slope when this option is selected.  The elevations of each cross 
section’s trapezoidal cuts are based on the user entered slope times the 
distance that each cross section is from the most downstream cross section.  
The distance is the cumulative main channel reach length for each of the 
individual cross sections. 

 
   A final option that can be applied to the selected range of cross sections is the 

Fill Channel option.  When this option is turned on, the main channel of the 
base cross-section data will be filled before any of the trapezoidal cuts are 
applied.  The main channel is filled to an elevation equal to the elevation of 
the lower of the two main channel bank stations. 
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   Once the user has filled in all of the desired data in the "Set Range of Values" 
data area, then the Apply Cuts to Selected Range button should be pressed.  
When this button is pressed, the lower table is filled with the specific 
information that will be applied to each of the cross sections in the selected 
range.  The cut information is then applied to each of the cross sections, and 
the graphic is updated to show both the existing cross section and the 
modified cross sections.    

 
   The user has the option of entering and modifying the channel modification 

data directly in the table at the bottom of the window, or they can use the "Set 
Range of Values" data area to apply a set of channel cut properties to a range 
of cross sections (this can be done several times for different ranges of cross 
sections within the reach).   

 
   A final option available to the user is Cut cross section until cut daylights 

once.  This is a global option that will be applied to all of the channel 
modification data.  When this option is selected, as the program performs the 
cutting of the trapezoidal channel, the left and right banks of the channel will 
start at the bottom of the trapezoid and cut through the ground until they 
reach open air, then the cutting will stop.  If this option is turned off, the left 
and right banks of the trapezoid will be projected to infinity, continually 
cutting any ground that lies above them. 

 
 

Performing the Channel Modifications 
 
   Once all of the desired channel modification data are entered for a reach, the 

user should press the Compute Cuts button at the top of the graphic.  When 
this button is pressed, all of the channel modification data from the lower 
table is applied and the graphic is updated to reflect the new cut information.  
The user can continue to modify the data and press the Compute Cuts button 
as many times as is necessary to get the desired cuts.  The cut information is 
always applied to the base geometry data.   

 
   Once the user has completed the desired channel modifications for the reach, 

they can view the cut and fill quantities by pressing the Cut and Fill Areas 
button.  When this button is pressed, a window will appear as shown in 
Figure 13.2. 
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 Figure 13.2  Channel Modification Cut and Fill Quantities 
 
    
   The cut and fill quantities table shows the cut, fill, and net areas and volumes 

for each of the individual cross sections, as well as the totals for the reach.  
The table shows the cut and fill quantities that were necessary in order to 
transform the existing cross-section data into the modified cross-section data.  
The areas and volumes are provided in the categories of left overbank, main 
channel, right overbank, and total.  These categories are based on the main 
channel bank stations of the base geometry data.  The volumes listed at a 
particular cross section, represent the volume between that cross section and 
the next downstream cross section.  The total volume and area at a particular 
cross section is the sum of the left overbank, main channel, and right 
overbank quantities for that individual cross section only.  Total volumes for 
the entire reach are listed at the bottom of the table.  The Cut and Fill 
Quantities table can be printed, sent to a file, or copied to the clipboard, by 
pressing the desired button at the bottom of the window. 

 
   The channel modification option has been set up to work with one Reach of 

the model at a time.  If the user needs to perform channel modifications to 
more than one reach of a multiple reach model, they can simply select a new 
reach at any time.  While the information in the tables and the graphic only 
show a single reach, the channel modification information is stored for all of 
the reaches.   
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   Once the user has finished all of the desired channel modifications, for all of 
the desired reaches, a new geometry file should be created for the modified 
geometry.  To create a modified geometry file, the user must enter a title for 
the modified geometry file in the upper right hand side of the window.  Once 
the new geometry file title is entered, the file can be created by pressing the 
Create Modified Geometry button at the bottom of the window.  When this 
button is pressed, a Save Geometry Data As window will appear.  The user 
has the options to change the directory in which the geometry file will be 
stored, change the name of the geometry file title, or select an existing 
geometry file to over write.  Once the user has decided on a title and a 
directory, the OK button can be pressed to save the modified geometry to the 
hard disk.  However, the original geometry file is still the one that is in 
memory.  If the user wants to work with the new modified geometry file, they 
will need to open it from the Geometric Data Editor window. 

 
   Note: the data entered into the channel modification editor is saved as part of 

the base geometry file (i.e., it is not saved with the modified geometry file).  
This allows the user to open the base geometry file and recreate the modified 
geometry.  In order for this data to be saved, the user must select Save 
Geometry Data from the file menu of the geometric data editor, after they 
have entered the channel modification data. 

 
 

Comparing Existing and Modified Conditions 
 
   Once a modified geometry file is created, the user can create a new plan that 

will incorporate the modified geometry and the previously defined flow data.  
This is accomplished by first opening the modified geometry file from the 
Geometric Data window.  The next step is to open the Steady Flow Analysis 
window and create a new Plan.  Creating a plan is accomplished by selecting 
New Plan from the File menu of the Steady Flow Analysis window.  Once a 
new plan is created, the computations can be performed.   

 
   After the water surface profile computations have been performed for the 

modified channel conditions, the user can compare the results of the existing 
and modified conditions on any of the graphics and tables.  An example 
cross-section plot of the two plans is shown in Figure 13.3.  Figure 13.3 
shows the geometry of the modified and existing conditions, along with the 
computed water surface elevations from both the existing and modified plans.  
To display the geometry and results from more than one plan on a graphic, 
the user can select Plan from the Options menu on any of the graphics.  At 
the top of the plan selection window, turn on the option that says “Compare 
Geometry As Well As Output.”  Select the two plans to be viewed and hit 
the OK button.  The geometry and output for both plans will be displayed. 

 
   In addition to graphical output, the user can review the computed results from 

both plans in a tabular form.  Figure 13.4 shows the computed results for both 
plans in Standard Table 1 of the Profile Output table. 
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 Figure 13.3   Existing and Modified Geometry and Water Surface Elevations 
    

 
  

Figure 13.4  Standard Table 1 With Existing and Modified Conditions   
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